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Sun Position

Unlimited Ammo

Foam Weapons
Ownship

Invulnerable
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Imagery

Open Street Maps

Vector Images Masks

Laser Line Camera Line Target Line

Engagement Range Weapon Text

Platform Text Engagement Zones

Waypoints

Networks

Radar

Radio/IR/Receiver

Detection RingsJammer CorridorTracks



▪ Add it to the QAT!
▪ Filter your map based on use case
▪ Save configs based on use case
▪ Look here first if things aren’t displaying

→ →

mailto:support@bssim.com
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1. (00:13) Open Tutorial_3.mis in MACE

2. (00:22) Zoom in and pan the map to the east then zoom out 

3. (00:28) Centre on the mission area

4. (00:33) Pick an Entity from the status bar and center on it.

5. (00:40) Measure the distance between 2 entities

6. (00:52) Remove measurement lines

7. (01:04) Use the Mouse + Control button to show an entity name

8. (01:14) Use the cursor to determine ground elevation and coordinate at a point

9. (01:18) Cycle through coordinate systems. Finish with MGRS

10. (01:22) Add the map measurement tool as a quick access toolbar button

11. (01:32) Use the layer manager to hide  OSM and imagery leaving only the vectors

12. (01:53) Switch OSM and imagery back on and adjust transparency of the imagery layer to 40%

mailto:support@bssim.com
https://youtu.be/v3FHqkld4XI
https://youtu.be/v3FHqkld4XI?t=00m13s
https://youtu.be/v3FHqkld4XI?t=00m22s
https://youtu.be/v3FHqkld4XI?t=00m28s
https://youtu.be/v3FHqkld4XI?t=00m33s
https://youtu.be/v3FHqkld4XI?t=00m40s
https://youtu.be/v3FHqkld4XI?t=00m52s
https://youtu.be/v3FHqkld4XI?t=01m04s
https://youtu.be/v3FHqkld4XI?t=01m14s
https://youtu.be/v3FHqkld4XI?t=01m18s
https://youtu.be/v3FHqkld4XI?t=01m22s
https://youtu.be/v3FHqkld4XI?t=01m32s
https://youtu.be/v3FHqkld4XI?t=01m53s
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MISSION BUILDER→ Mission Builder Toolbox

BSI / QUICK MENU

mailto:support@bssim.com
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LMB = Left Mouse Button
RMB = Right Mouse ButtonSHORTCUTS
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mailto:support@bssim.com
https://youtu.be/mC8zGlXm7LA
https://youtu.be/mC8zGlXm7LA?t=13
https://youtu.be/mC8zGlXm7LA?t=18
https://youtu.be/mC8zGlXm7LA?t=66
https://youtu.be/mC8zGlXm7LA?t=92
https://youtu.be/mC8zGlXm7LA?t=110
https://youtu.be/mC8zGlXm7LA?t=120
https://youtu.be/mC8zGlXm7LA?t=137
https://youtu.be/mC8zGlXm7LA?t=146
https://youtu.be/mC8zGlXm7LA?t=154
https://youtu.be/mC8zGlXm7LA?t=170
https://youtu.be/mC8zGlXm7LA?t=187
https://youtu.be/mC8zGlXm7LA?t=208
https://youtu.be/mC8zGlXm7LA?t=225
https://youtu.be/mC8zGlXm7LA?t=242
https://youtu.be/mC8zGlXm7LA?t=251
https://youtu.be/mC8zGlXm7LA?t=262
https://youtu.be/mC8zGlXm7LA?t=275
https://youtu.be/mC8zGlXm7LA?t=289


43BSI

Copyright BSI © 2025
43

▪

▪

▪

▪

▪

▪

▪

▪

▪

▪

▪

▪

mailto:support@bssim.com


45BSI

Copyright BSI © 2025
45

▪

▪

▪

▪

▪

▪

▪

▪

▪

▪

▪

▪

▪

▪

▪

▪

mailto:support@bssim.com


46BSI

Copyright BSI © 2025

Q W E R T Y U I O P [ ]

backspace
+
=

̶ 
-

)
0

(
9

*
8

&
7

^
6

%
5

$
4

£
3

“
2

!
1

`
¬

tab

A S D F G H J K L
:
;

@
‘

~
#

caps lock

Z X C V B N M
<
,

>
.

?
/

|
\

shift shift

ctrl start alt ctrlalt grspacebar

↑

 ↓ →

insert home
page

up

del end
Page
down

F12F11F10F9F8F7F6F5F4F3F2F1
Esc

Pr Scn

Enter
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CRTL
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LEFT
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RIGHTFWD
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Lshift
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Label Type Filter

Label Compact / Large
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page
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alt
page

up

page
down

page
down

IR Manual Temp
Upper limit up/down

ctrl end IR Auto temperature range

Sensor Spectrum

Sensor Polarity

Zshift

Xshift

Main Spectrum

Main Polarity

Z

X

mailto:support@bssim.com


49BSI

Copyright BSI © 2025
49

mailto:support@bssim.com


50BSI

Copyright BSI © 2025
50

Label Team Filter

Label Type Filter

Compact / Detailed

mailto:support@bssim.com
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Trail Team Filter

Trail Type Filter

mailto:support@bssim.com
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Cycle waypoint entity

Waypoint label mode

mailto:support@bssim.com
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EO Night IR IRC
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Student Exercise – Link to Online Solution Video
1. (00:13) Open the ARMOR plugin from the View tab

2. (00:18) Set the correct ARMOR application path in the MACE-ARMOR Plugin 

3. (00:33) Set a valid terrain data path in the MACE-ARMOR plugin and verify on the MACE map

4. (00:52) Launch ARMOR from the MACE-ARMOR Plugin 

5. (01:09) Open Tutorial_3.mis in MACE – observe ARMOR connecting to the mission

6. (01:22) Start the mission in MACE

7. (01:25) Select an aircraft entity in MACE then select ARMOR and attach to an entity [Spacebar]

8. (01:55) Use the number keys to cycle through attached views 1 to 9

9. (02:27) Reselect view 1 and bring up the picture in picture camera view by pressing 0

10. (02:33) Detach from the platform [Spacebar]

11. (02:36) Maneuver the camera in 6 degrees of freedom

12. (02:49) Open the OSI [Tab]

13. (02:54) Use the OSI to select: Abbreviated labels, outlines, medium trails, and waypoints

14. (03:25) Open the viewpoints function on the OSI

15. (03:29) Maneuver the camera to a different position; name and save the viewpoint

16. (03:40) Maneuver the camera to a different position – restore the viewpoint

17. (03:50) Change the view spectrums until you get back to normal EO 

mailto:support@bssim.com
https://www.youtube.com/watch?v=6NCDOvZNF5o
https://youtu.be/6NCDOvZNF5o?t=13
https://youtu.be/6NCDOvZNF5o?t=18
https://youtu.be/6NCDOvZNF5o?t=33
https://youtu.be/6NCDOvZNF5o?t=51
https://youtu.be/6NCDOvZNF5o?t=69
https://youtu.be/6NCDOvZNF5o?t=81
https://youtu.be/6NCDOvZNF5o?t=85
https://youtu.be/6NCDOvZNF5o?t=115
https://youtu.be/6NCDOvZNF5o?t=147
https://youtu.be/6NCDOvZNF5o?t=153
https://youtu.be/6NCDOvZNF5o?t=156
https://youtu.be/6NCDOvZNF5o?t=169
https://youtu.be/6NCDOvZNF5o?t=174
https://youtu.be/6NCDOvZNF5o?t=205
https://youtu.be/6NCDOvZNF5o?t=209
https://youtu.be/6NCDOvZNF5o?t=220
https://youtu.be/6NCDOvZNF5o?t=230
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^
Delta (not following waypoints)

Waypoint following (Intent)

Rallying

Moving to target

Running away

Taking cover

Random destination

Joystick controlled

In formation

mailto:support@bssim.com
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YELLOW = INSTANT
RED = TARGET VALUE

mailto:support@bssim.com
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Weapon Release

Auto Enabled Weapons
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SHORTCUTS
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mailto:support@bssim.com
https://youtu.be/_GA9nwNuzTY
https://youtu.be/_GA9nwNuzTY?t=13
https://youtu.be/_GA9nwNuzTY?t=58
https://youtu.be/_GA9nwNuzTY?t=73
https://youtu.be/_GA9nwNuzTY?t=109
https://youtu.be/_GA9nwNuzTY?t=114
https://youtu.be/_GA9nwNuzTY?t=155
https://youtu.be/_GA9nwNuzTY?t=169
https://youtu.be/_GA9nwNuzTY?t=230
https://youtu.be/_GA9nwNuzTY?t=242
https://youtu.be/_GA9nwNuzTY?t=259
https://youtu.be/_GA9nwNuzTY?t=264
https://youtu.be/_GA9nwNuzTY?t=266
https://youtu.be/_GA9nwNuzTY?t=277
https://youtu.be/_GA9nwNuzTY?t=283
https://youtu.be/_GA9nwNuzTY?t=290
https://youtu.be/_GA9nwNuzTY?t=312
https://youtu.be/_GA9nwNuzTY?t=320
https://youtu.be/_GA9nwNuzTY?t=329
https://youtu.be/_GA9nwNuzTY?t=338
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Wait while terrain generates

(8) First Load – Terrain Tiles Cache in ARMOR
Must have an entity placed in MACE to start this process

mailto:support@bssim.com
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See Existing Tiles
Pick terrain area (3-ways)

Zoom MACE Map

Draw a rectangle

Open a pervious area

Type corner coordinates

Check Root Level Folder – ARMOR Terrain
Name new terrain

ARMOR Terrain
  Sardinia 
  Pacific Northwest
  A N Other Terrain
  A N Other Terrain 2

mailto:support@bssim.com
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Wait while terrain generates

(8) First Load – Terrain Tiles Cache in ARMOR
Must have an entity placed in MACE to start this process
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Student Exercise  Link to Online Solution Video

mailto:support@bssim.com
https://www.youtube.com/watch?v=9RMpeqrXdug
https://youtu.be/9RMpeqrXdug?t=16
https://youtu.be/9RMpeqrXdug?t=49
https://youtu.be/9RMpeqrXdug?t=60
https://youtu.be/9RMpeqrXdug?t=71
https://youtu.be/9RMpeqrXdug?t=88
https://youtu.be/9RMpeqrXdug?t=109
https://youtu.be/9RMpeqrXdug?t=113
https://youtu.be/9RMpeqrXdug?t=124
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TOP LOCK
Visuals & Displays 

(Ownship)
Locked to this platform

▪

▪
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▪

▪
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87Note 1: if using Tactical-Display plugin to enable zoom on the pod FLIR must be engaged

Note 2: Next Target is disabled when using Tactical Display

AIRCRAFT CONTROL

POD CONTROL

TAC DISPLAY CONTROL

mailto:support@bssim.com
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KDTS 220953Z AUTO 00000KT 10SM CLR 26/23 
A2979 RMK AO2 SLP086 T02560233
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mailto:support@bssim.com
https://www.youtube.com/watch?v=5HYdhK15Uf8
https://youtu.be/5HYdhK15Uf8?t=16
https://youtu.be/5HYdhK15Uf8?t=30
https://youtu.be/5HYdhK15Uf8?t=48
https://youtu.be/5HYdhK15Uf8?t=64
https://youtu.be/5HYdhK15Uf8?t=94
https://youtu.be/5HYdhK15Uf8?t=102
https://youtu.be/5HYdhK15Uf8?t=115
https://youtu.be/5HYdhK15Uf8?t=137
https://youtu.be/5HYdhK15Uf8?t=143
https://youtu.be/5HYdhK15Uf8?t=143
https://youtu.be/5HYdhK15Uf8?t=161
https://youtu.be/5HYdhK15Uf8?t=168
https://youtu.be/5HYdhK15Uf8?t=178
https://youtu.be/5HYdhK15Uf8?t=204
https://youtu.be/5HYdhK15Uf8?t=224
https://youtu.be/5HYdhK15Uf8?t=259
https://youtu.be/5HYdhK15Uf8?t=266
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mailto:support@bssim.com
https://www.youtube.com/watch?v=5HYdhK15Uf8
https://youtu.be/5HYdhK15Uf8?t=309
https://youtu.be/5HYdhK15Uf8?t=322
https://youtu.be/5HYdhK15Uf8?t=349
https://youtu.be/5HYdhK15Uf8?t=373
https://youtu.be/5HYdhK15Uf8?t=419
https://youtu.be/5HYdhK15Uf8?t=453
https://youtu.be/5HYdhK15Uf8?t=464
https://youtu.be/5HYdhK15Uf8?t=468
https://youtu.be/5HYdhK15Uf8?t=482
https://youtu.be/5HYdhK15Uf8?t=500
https://youtu.be/5HYdhK15Uf8?t=511
https://youtu.be/5HYdhK15Uf8?t=519
https://youtu.be/5HYdhK15Uf8?t=551
https://youtu.be/5HYdhK15Uf8?t=592
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1. (00:16) Add 2 FW Ground Attack Aircraft, 2 Cars, 4 EF Ground Forces as group 1 and 4 Friendly Forces as group 2

2. (01:33) Recall the groups and move them so that they are in line of sight of each other

3. (01:52) Set the weapon posture on 1 EF to 'Free' and the other to 'Tight' and on the 'Tight' entity target a FF entity

4. (02:08) Set FF postures to 'Do Nothing', 'Run Away', 'Fight Back', and 'Take Cover

5. (02:40) Set 'Foam Weapon Mode' for the mission

6. (02:45) Start the mission and observe the engagements between FF and EF

7. (03:10) Deselect 'Foam Weapon Mode' - observe platform death

8. (03:26) Stop the mission, resurrect the dead entities, return to intent, and make all entities 'Weapons Hold

9. (03:51) Add a cultural building, destroy it with the detonation tool, then start the mission

10. (04:30) Ensure one of the FW attack aircraft has as its selected weapon an air to ground weapon

11. (04:41) Assign a vehicle as the aircraft's target, then select 'Move to Target' and 'Weapons Tight'

12. (05:40) After it releases the weapon, return to intent

13. (05:57) Use the instant Blue vs Red attack [Ctrl + RMB] to attack an enemy entity with the FW aircraft

mailto:support@bssim.com
https://www.youtube.com/watch?v=j5zsHPrkk_k
https://youtu.be/j5zsHPrkk_k?t=16
https://youtu.be/j5zsHPrkk_k?t=93
https://youtu.be/j5zsHPrkk_k?t=112
https://youtu.be/j5zsHPrkk_k?t=128
https://youtu.be/j5zsHPrkk_k?t=160
https://youtu.be/j5zsHPrkk_k?t=165
https://youtu.be/j5zsHPrkk_k?t=190
https://youtu.be/j5zsHPrkk_k?t=206
https://youtu.be/j5zsHPrkk_k?t=231
https://youtu.be/j5zsHPrkk_k?t=270
https://youtu.be/j5zsHPrkk_k?t=281
https://youtu.be/j5zsHPrkk_k?t=341
https://youtu.be/j5zsHPrkk_k?t=357
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File>Import/Export

POLYGON((3.0549976 
39.94038840000001,3.0604907 
40.12545119999999,2.5496265000000005 
40.13070129999999,2.54276 
39.970916199999984,2.8709765999999997 
39.969863799999985,2.8708049 
39.932885899999995,3.055046 
39.93324580000002,3.0549976 
39.94038840000001))

mailto:support@bssim.com
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Pre 2024 MACE View>IG View Post 2024 MACE Layer Manager
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(1) Quick Colour Changes from the context Menu
(2) All other changes use the VIEW → Layer Manager → Map → Vector Images

Layer Manager > Map > Vector Images Transparency Label (MACE Only) 3D Properties – top/bottom height

TIP – REMEMBER TO SAVE CHANGES

Changes can only be saved by pressing save button in bottom lefthand corner

mailto:support@bssim.com
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Show controlled airspace in ARMOR only
Place .kmz files in C:\Users\Public\Documents\ARMOR\Airspaces
Airspace – 3D Airspace (https://3dairspace.org.uk/airspace/)

Activate from 
OSI – Visualizations Menu 

Keyboard Shortcut – K

mailto:support@bssim.com
https://3dairspace.org.uk/airspace/
https://3dairspace.org.uk/airspace/
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mailto:support@bssim.com
https://www.youtube.com/watch?v=hpD5ydnKStY
https://youtu.be/hpD5ydnKStY?t=16
https://youtu.be/hpD5ydnKStY?t=34
https://youtu.be/hpD5ydnKStY?t=102
https://youtu.be/hpD5ydnKStY?t=162
https://youtu.be/hpD5ydnKStY?t=201
https://youtu.be/hpD5ydnKStY?t=263
https://youtu.be/hpD5ydnKStY?t=283
https://youtu.be/hpD5ydnKStY?t=296
https://youtu.be/hpD5ydnKStY?t=360
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In Intent (follows Waypoints)
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WAYPOINTS AND ROUTES

Copying Waypoints / Copying Waypoints & Platforms

Platform Properties> Copy / Move Platform

Same as ENTITY CONTROLS>PLATFORM MANOEUVRE 

WAYPOINT PROPERTIES

mailto:support@bssim.com
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mailto:support@bssim.com
https://www.youtube.com/watch?v=DG4nbVI3lz8
https://youtu.be/DG4nbVI3lz8?t=16
https://youtu.be/DG4nbVI3lz8?t=66
https://youtu.be/DG4nbVI3lz8?t=111
https://youtu.be/DG4nbVI3lz8?t=143
https://youtu.be/DG4nbVI3lz8?t=163
https://youtu.be/DG4nbVI3lz8?t=176
https://youtu.be/DG4nbVI3lz8?t=176
https://youtu.be/DG4nbVI3lz8?t=248
https://youtu.be/DG4nbVI3lz8?t=293
https://youtu.be/DG4nbVI3lz8?t=319
https://youtu.be/DG4nbVI3lz8?t=346
https://youtu.be/DG4nbVI3lz8?t=408
https://youtu.be/DG4nbVI3lz8?t=476
https://youtu.be/DG4nbVI3lz8?t=493
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15. (11:16) Use the entity controls tab to make the helicopter to take off, and return to the route and at the next waypoint, proceed to another 
waypoint, where it should stop 

16. (13:25) (if you have road vectors) attach one of your ground vehicles to the road; if not, draw a line and attach to the line 

mailto:support@bssim.com
https://www.youtube.com/watch?v=DG4nbVI3lz8
https://youtu.be/DG4nbVI3lz8?t=676
https://youtu.be/DG4nbVI3lz8?t=805
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(optionally) specify 

favourites

Platform Properties → Navigational

mailto:support@bssim.com
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mailto:support@bssim.com
https://www.youtube.com/watch?v=ezDQkdtst_A
https://youtu.be/ezDQkdtst_A?t=16
https://youtu.be/ezDQkdtst_A?t=143
https://youtu.be/ezDQkdtst_A?t=191
https://youtu.be/ezDQkdtst_A?t=210
https://youtu.be/ezDQkdtst_A?t=225
https://youtu.be/ezDQkdtst_A?t=244
https://youtu.be/ezDQkdtst_A?t=259
https://youtu.be/ezDQkdtst_A?t=381
https://youtu.be/ezDQkdtst_A?t=496
https://youtu.be/ezDQkdtst_A?t=525
https://youtu.be/ezDQkdtst_A?t=541
https://youtu.be/ezDQkdtst_A?t=553
https://youtu.be/ezDQkdtst_A?t=564
https://youtu.be/ezDQkdtst_A?t=604
https://youtu.be/ezDQkdtst_A?t=625
https://youtu.be/ezDQkdtst_A?t=638
https://youtu.be/ezDQkdtst_A?t=659
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AUTONOMOUS PLATFORM
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mailto:support@bssim.com
https://www.youtube.com/watch?v=16lJ7HEl8Y0
https://youtu.be/16lJ7HEl8Y0?t=31
https://youtu.be/16lJ7HEl8Y0?t=36
https://youtu.be/16lJ7HEl8Y0?t=54
https://youtu.be/16lJ7HEl8Y0?t=92
https://youtu.be/16lJ7HEl8Y0?t=126
https://youtu.be/16lJ7HEl8Y0?t=144
https://youtu.be/16lJ7HEl8Y0?t=170
https://youtu.be/16lJ7HEl8Y0?t=212
https://youtu.be/16lJ7HEl8Y0?t=236
https://youtu.be/16lJ7HEl8Y0?t=282
https://youtu.be/16lJ7HEl8Y0?t=372
https://youtu.be/16lJ7HEl8Y0?t=426
https://youtu.be/16lJ7HEl8Y0?t=470
https://youtu.be/16lJ7HEl8Y0?t=540
https://youtu.be/16lJ7HEl8Y0?t=591
https://youtu.be/16lJ7HEl8Y0?t=703
https://youtu.be/16lJ7HEl8Y0?t=725
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https://www.youtube.com/watch?v=16lJ7HEl8Y0
https://youtu.be/16lJ7HEl8Y0?t=743
https://youtu.be/16lJ7HEl8Y0?t=774
https://youtu.be/16lJ7HEl8Y0?t=804
https://youtu.be/16lJ7HEl8Y0?t=854
https://youtu.be/16lJ7HEl8Y0?t=919
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Weapons and Equipment

Layer Manager
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Weapons and Equipment – on Jammed Platform

Jammed (in last 15s)

mailto:support@bssim.com


148BSI

Copyright BSI © 2025
148

mailto:support@bssim.com


149BSI

Copyright BSI © 2025
149

mailto:support@bssim.com


150BSI

Copyright BSI © 2025
150

mailto:support@bssim.com
https://www.youtube.com/watch?v=uBovsJIz4fw
https://youtu.be/uBovsJIz4fw?t=14
https://youtu.be/uBovsJIz4fw?t=41
https://youtu.be/uBovsJIz4fw?t=52
https://youtu.be/uBovsJIz4fw?t=96
https://youtu.be/uBovsJIz4fw?t=166
https://youtu.be/uBovsJIz4fw?t=179
https://youtu.be/uBovsJIz4fw?t=192
https://youtu.be/uBovsJIz4fw?t=201
https://youtu.be/uBovsJIz4fw?t=221
https://youtu.be/uBovsJIz4fw?t=246
https://youtu.be/uBovsJIz4fw?t=282
https://youtu.be/uBovsJIz4fw?t=289
https://youtu.be/uBovsJIz4fw?t=313
https://youtu.be/uBovsJIz4fw?t=337
https://youtu.be/uBovsJIz4fw?t=369
https://youtu.be/uBovsJIz4fw?t=405
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https://www.youtube.com/watch?v=uBovsJIz4fw
https://youtu.be/uBovsJIz4fw?t=430
https://youtu.be/uBovsJIz4fw?t=469
https://youtu.be/uBovsJIz4fw?t=502
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mailto:support@bssim.com
https://www.youtube.com/watch?v=0AN07UmGrOg
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=9
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=17
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=47
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=53
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=60
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=80
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=180
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=240
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=261
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=272
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=288
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=330
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=364
https://youtu.be/0AN07UmGrOg?list=PLa0gPXcTHmLEb-fO1FbmjrpUsvzl5hUW8&t=368
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mailto:support@bssim.com
https://www.youtube.com/watch?v=BDHVGsHtJwo
https://youtu.be/BDHVGsHtJwo?t=9
https://youtu.be/BDHVGsHtJwo?t=21
https://youtu.be/BDHVGsHtJwo?t=57
https://youtu.be/BDHVGsHtJwo?t=109
https://youtu.be/BDHVGsHtJwo?t=143
https://youtu.be/BDHVGsHtJwo?t=199
https://youtu.be/BDHVGsHtJwo?t=228
https://youtu.be/BDHVGsHtJwo?t=232
https://youtu.be/BDHVGsHtJwo?t=260
https://youtu.be/BDHVGsHtJwo?t=306
https://youtu.be/BDHVGsHtJwo?t=329
https://youtu.be/BDHVGsHtJwo?t=350
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https://www.youtube.com/watch?v=BDHVGsHtJwo
https://youtu.be/BDHVGsHtJwo?t=374
https://youtu.be/BDHVGsHtJwo?t=411
https://youtu.be/BDHVGsHtJwo?t=449
https://youtu.be/BDHVGsHtJwo?t=508
https://youtu.be/BDHVGsHtJwo?t=546
https://youtu.be/BDHVGsHtJwo?t=589
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mailto:support@bssim.com
https://www.youtube.com/watch?v=auSf36hAIMo
https://youtu.be/auSf36hAIMo?t=10
https://youtu.be/auSf36hAIMo?t=17
https://youtu.be/auSf36hAIMo?t=46
https://youtu.be/auSf36hAIMo?t=93
https://youtu.be/auSf36hAIMo?t=121
https://youtu.be/auSf36hAIMo?t=139
https://youtu.be/auSf36hAIMo?t=167
https://youtu.be/auSf36hAIMo?t=186
https://youtu.be/auSf36hAIMo?t=205
https://youtu.be/auSf36hAIMo?t=249
https://youtu.be/auSf36hAIMo?t=321
https://youtu.be/auSf36hAIMo?t=342
https://youtu.be/auSf36hAIMo?t=377
https://youtu.be/auSf36hAIMo?t=393
https://youtu.be/auSf36hAIMo?t=425
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https://www.youtube.com/watch?v=auSf36hAIMo
https://youtu.be/auSf36hAIMo?t=470
https://youtu.be/auSf36hAIMo?t=486
https://youtu.be/auSf36hAIMo?t=527
https://youtu.be/auSf36hAIMo?t=551
https://youtu.be/auSf36hAIMo?t=599
https://youtu.be/auSf36hAIMo?t=614
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mailto:support@bssim.com
https://www.youtube.com/watch?v=P5g3KWbB2U8
https://youtu.be/P5g3KWbB2U8?t=11
https://youtu.be/P5g3KWbB2U8?t=86
https://youtu.be/P5g3KWbB2U8?t=132
https://youtu.be/P5g3KWbB2U8?t=197
https://youtu.be/P5g3KWbB2U8?t=264
https://youtu.be/P5g3KWbB2U8?t=276
https://youtu.be/P5g3KWbB2U8?t=321
https://youtu.be/P5g3KWbB2U8?t=396
https://youtu.be/P5g3KWbB2U8?t=406
https://youtu.be/P5g3KWbB2U8?t=428
https://youtu.be/P5g3KWbB2U8?t=517
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mailto:support@bssim.com
https://www.youtube.com/watch?v=9Vt9mMVFfOA
https://youtu.be/9Vt9mMVFfOA?t=9
https://youtu.be/9Vt9mMVFfOA?t=208
https://youtu.be/9Vt9mMVFfOA?t=284
https://youtu.be/9Vt9mMVFfOA?t=308
https://youtu.be/9Vt9mMVFfOA?t=410
https://youtu.be/9Vt9mMVFfOA?t=425
https://youtu.be/9Vt9mMVFfOA?t=559
https://youtu.be/9Vt9mMVFfOA?t=568
https://youtu.be/9Vt9mMVFfOA?t=719
https://youtu.be/9Vt9mMVFfOA?t=738
https://youtu.be/9Vt9mMVFfOA?t=762
https://youtu.be/9Vt9mMVFfOA?t=793
https://youtu.be/9Vt9mMVFfOA?t=827
https://youtu.be/9Vt9mMVFfOA?t=879
https://youtu.be/9Vt9mMVFfOA?t=910
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https://www.youtube.com/watch?v=9Vt9mMVFfOA
https://youtu.be/9Vt9mMVFfOA?t=1025
https://youtu.be/9Vt9mMVFfOA?t=1040
https://youtu.be/9Vt9mMVFfOA?t=1100
https://youtu.be/9Vt9mMVFfOA?t=1144
https://youtu.be/9Vt9mMVFfOA?t=1209
https://youtu.be/9Vt9mMVFfOA?t=1221
https://youtu.be/9Vt9mMVFfOA?t=1245
https://youtu.be/9Vt9mMVFfOA?t=1300
https://youtu.be/9Vt9mMVFfOA?t=1317
https://youtu.be/9Vt9mMVFfOA?t=1329
https://youtu.be/9Vt9mMVFfOA?t=1467
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1. (00:09) Place a JTAC and several EF platforms on the ground including: - moving vehicles  on a route - cultural buildings (from MACE Cultural)

2. (03:24) Add a ground-attack aircraft (e.g. Generic Fighter) - ensure it has a mixture of laser guided bombs, missiles and a laser designator - 
place it in an out of intent racetrack 

3. (03:54) Duplicate the platform and place the duplicate in formation with the first aircraft

4. (04:09) Use the ‘System Settings’ options to select weather attenuation on 

5. (04:18) Use ‘Mission Settings’ set the environment visibility to 5,000m 

6. (04:26) Add a human entity about 1km from one of the static targets - Equip them with a laser designator - Allocate a target and check line of 
sight to it

7. (05:23) Change the human’s ‘Laser Code’ (PRF) in ‘Platform Properties’ to 1688 - Manually fire the laser at the target and cease - Verify the 
PRF by looking at the code displayed by the target on the MACE map. 

8. (05:39) Start the mission - (Optionally) setup ARMOR in a way that best allows you to observe attacks with trails and labels as you like them

9. (06:02) Set up a 9 Line so that the aircraft does not designate its own weapon - select a laser-guided weapon (e.g. Generic GBU) - ensure the 
PRF on the air asset matches the PRF for your ground platform (1688) - pick the target from the map but click near to the target that is to be 
designated by the ground platform by about 50m - check the FAH is within a good laser arc for the lasing ground entity - set release point 
for 50% max weapon range 

10. (06:45) Set a reasonable TTT (using the Estimate TTT function)

11. (07:01) Attack without IP & Clear Hot

12. (07:32) Ensure Weapons Guidance and Target Line are selected in the layer manager Weapons Section

mailto:support@bssim.com
mailto:https://www.youtube.com/watch?v=6MwZf109oas
https://youtu.be/6MwZf109oas?t=9
https://youtu.be/6MwZf109oas?t=204
https://youtu.be/6MwZf109oas?t=234
https://youtu.be/6MwZf109oas?t=249
https://youtu.be/6MwZf109oas?t=258
https://youtu.be/6MwZf109oas?t=266
https://youtu.be/6MwZf109oas?t=323
https://youtu.be/6MwZf109oas?t=339
https://youtu.be/6MwZf109oas?t=362
https://youtu.be/6MwZf109oas?t=405
https://youtu.be/6MwZf109oas?t=421
https://youtu.be/6MwZf109oas?t=452
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mailto:https://www.youtube.com/watch?v=6MwZf109oas
https://youtu.be/6MwZf109oas?t=452
https://youtu.be/6MwZf109oas?t=475
https://youtu.be/6MwZf109oas?t=495
https://youtu.be/6MwZf109oas?t=514
https://youtu.be/6MwZf109oas?t=544
https://youtu.be/6MwZf109oas?t=598
https://youtu.be/6MwZf109oas?t=647
https://youtu.be/6MwZf109oas?t=691
https://youtu.be/6MwZf109oas?t=765
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https://youtu.be/k2PGZ5Y74ww
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https://www.youtube.com/watch?v=Z4llW1LD1_M
https://youtu.be/Z4llW1LD1_M?t=12
https://youtu.be/Z4llW1LD1_M?t=56
https://youtu.be/Z4llW1LD1_M?t=105
https://youtu.be/Z4llW1LD1_M?t=125
https://youtu.be/Z4llW1LD1_M?t=160
https://youtu.be/Z4llW1LD1_M?t=191
https://youtu.be/Z4llW1LD1_M?t=207
https://youtu.be/Z4llW1LD1_M?t=219
https://youtu.be/Z4llW1LD1_M?t=231
https://youtu.be/Z4llW1LD1_M?t=257
https://youtu.be/Z4llW1LD1_M?t=278
https://youtu.be/Z4llW1LD1_M?t=284
https://youtu.be/Z4llW1LD1_M?t=293
https://youtu.be/Z4llW1LD1_M?t=312
https://youtu.be/Z4llW1LD1_M?t=340
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mailto:support@bssim.com
https://www.youtube.com/watch?v=Z4llW1LD1_M
https://youtu.be/Z4llW1LD1_M?t=350
https://youtu.be/Z4llW1LD1_M?t=356
https://youtu.be/Z4llW1LD1_M?t=378
https://youtu.be/Z4llW1LD1_M?t=395
https://youtu.be/Z4llW1LD1_M?t=424
https://youtu.be/Z4llW1LD1_M?t=434
https://youtu.be/Z4llW1LD1_M?t=455
https://youtu.be/Z4llW1LD1_M?t=497
https://youtu.be/Z4llW1LD1_M?t=517
https://youtu.be/Z4llW1LD1_M?t=555
https://youtu.be/Z4llW1LD1_M?t=580
https://youtu.be/Z4llW1LD1_M?t=605
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https://www.youtube.com/watch?v=Z4llW1LD1_M
https://youtu.be/Z4llW1LD1_M?t=617
https://youtu.be/Z4llW1LD1_M?t=629
https://youtu.be/Z4llW1LD1_M?t=651
https://youtu.be/Z4llW1LD1_M?t=660
https://youtu.be/Z4llW1LD1_M?t=666
https://youtu.be/Z4llW1LD1_M?t=687
https://youtu.be/Z4llW1LD1_M?t=740
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1. () Make a New MACE Mission

2. () 

3. () Use Group Add to add a VIC presentation of 3 groups of 3 Enemy Fighter Aircraft about 50nm away

4. () 

5. () 

6. ()

7. () Save the mission and start then pause it

8. () 

9. () 

10. () 

11. () 

12. () Display the waypoints, waypoint sequence, known points 

13. () Add a buttonized scri

14. () Run the mission on 

15. () 

16. () Select a target 

17. () Access the weapons page and select a weapon for engaging the target (ideally an active or semi active missile)

mailto:support@bssim.com
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Virtual Entity

Virtual World

Real World

Virtual Effect

Real World
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F1

F2

F3

CTRL

CTRL

CTRL

VR Controller Interface in ARMOR

Steam-Deck ARMOR Config
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Swap menu hand

Rotate View

Left/Right

Translate

In direction relative to controller
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Pan

Single Trigger Click and ‘pull/push’ terrain

Zoom Out

Double Trigger Pull Beams Together
Zoom In

Double Trigger Pull Beams Apart

Rotate

Double Trigger Cross Beams Around a 

Centre Point
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In Intent (follows Waypoints)

Delta (not following waypoints)
^

Rallying

Moving to Target

Running Away

Random Walk

Joystick Controlled

Taking Cover

In formation
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Control Zones

Labels (Short)

Outlines (Long)
Beams

Designators

Airspaces

Threat Domes

WEZs

Trails

On Screen Interface

Waypoints

Spectrum (Short)

Polarity (Long)

Toggle Attach (Short)

Attach Mode (Long)

Spectrum (Short)

Polarity (Long)
Toggle Attach (Short)

Attach Mode (Long)

Pan left/right 

<A> <D>

Pan fwd/back

<W> <S>

Rotate left/right 

Tilt fwd/back

Pan up/down 

<R> <F>
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